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Chapter 1 
Introducing the Program 

Welcome to the Pension Distributions Planner 

Brentmark offers four different programs in the area of planning for distributions from 
qualified retirement plans: Pension Distributions Planner, Pension Distributions 
Calculator, Minimum Distributions Calculator, and the Pension & Roth IRA Analyzer. 

All the programs illustrate minimum distributions both during lifetime and after death, 
including those for Stretch IRAs, Rollovers, Inherited IRAs, Roth IRAs, and Roth 
401(k)s.  They also let you illustrate the effects of continuing to make contributions and 
of distributing more than the minimum required amount. 

The Pension Distributions Planner, Pension Distributions Calculator, and Pension & Roth 
IRA Analyzer also illustrate the substantially equal periodic payments needed to make 
pre-59½ distributions (also known as section 72(t) distributions) without incurring the 
10% penalty. 

The Pension Distributions Planner and Pension & Roth IRA Analyzer also lets you 
illustrate distributions to multiple beneficiaries.  They handle the separate accounts rule 
and the case where distributions are governed by the oldest beneficiary. 

The Pension & Roth IRA Analyzer goes far beyond the other products – including 
income and estate taxes, gifting, insurance, Roth conversions, and much more.  It is 
beyond the scope of this manual. 

In addition to this manual, the software comes with a comprehensive help system that 
includes relevant revenue rulings, IRS Notices, private letter rulings, and expert analysis 
of key calculation areas. 

Installation 

Getting started with the software is easy. Before you install the program, be sure that 
you’re running a Windows 95 or later operating system. The software does not run on 
Windows 3.1 or earlier operating systems. 

Installing the Program 

Insert the disk into the disk drive. 
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If the installation program doesn’t start automatically, then click the Start button on the 
Windows taskbar.  On the Start menu, click Run. The Run dialog box appears. In the 
Open box, type “D:\setup.exe” (replacing “D” with the drive letter of your CD drive). 

Click OK. 

The setup program begins. Follow the instructions in the setup program. 

Uninstalling the Program 

Run the Windows Control Panel (located on the Start Menu) and click Add/Remove 
Programs . 

Use the scrollbar to find the program. When you find it, click the program title. Notice 
that the Add/Remove button is now functional. 

Click the Add/Remove button. 

The uninstall program begins. Follow the instruction in the uninstall program. 

What Do I See on the Screen?       

When you run the program, the main window opens. Following are brief descriptions of 
what you see. 

Title Bar 

The title bar appears in the top of the window. It contains the following information: 

• Program Title 

• Program version number 

• File name (if a file has been loaded) 

Menu Bar 

 
The Menu bar is below the title bar. The Menu bar contains three menus that you use to 
make program commands.  
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Toolbar 

The toolbar is below the menu bar. The toolbar contains graphics that you click to 
execute frequently used program commands. You can use these graphics instead of using 
the related Menu bar commands.  

  

 

 

Data Entry Section 

A data entry section appears in the left side of the window. Use this section to enter the 
information needed for the calculations. 

Command Buttons 

Two command buttons appear below the data entry section. Use these to enter additional 
distributions and contributions. 

Display Area 

The right side of the window is the display area. Here, you can view graphs or reports 
that display the results of the calculations. 

Hint Line 

The Hint Line  displays short commands to help you with data entry. As you move the 
pointer across buttons, input boxes, and other areas of the window, the Hint Line  
displays different commands. 

Shortcut Keys 

Use the function keys for frequently used commands: 

F1 Access the Help system. 

F2 Save files. 

Open Files. 

Save Files. Print Files. Get Help. 

Brentmark Online. 
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F3 Open files. 

F6 Print reports. 

F7 Create a new file. 
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Chapter 2 
Working with Files 

 

Frequently Used Procedures 

Refer to this chapter to view instructions for procedures that you’ll frequently use when 
working with files. 

Create a New File       

On the File menu, click New. The program clears all previous data entry and resets the 
program’s default va lues. 

Open an Existing File       

1. On the File menu click Open. Or on the toolbar, click the Open graphic. The Open 
dialog box appears.  You can also select Reopen File to quickly reopen a file you’ve 
been working with. 

2. In the File name box, enter the name of the file and the proper extension. Be sure you 
have selected the proper drive and folder that contain your file. 

Reopen File 

On the File menu, click Reopen File. A list of files you’ve worked on recently will 
appear. Select the name of the file you wish to reopen. 

Save a File       

1. On the File menu, click Save. Or on the toolbar, click the Save graphic.  

2. If the file has not been saved previously, the Save As dialog box appears. 

3. Select the drive and folder in which to save the file. 

4. In the File name  box, type a name for the file. The program automatically adds .PDC 
extension to the file name. 

Copy an Existing File (Save As)      

1. Open an existing file or create a new file. 
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2. On the File menu, click Save As. Or on the toolbar, click the Save graphic. The Save 
As dialog box appears. 

3. Select the drive and folder in which you want to save the file. 

4. In the File name box, enter a name for the new file. The program automatically adds 
the proper extension to the file name. 

Access the Print Report Window       

On the File menu, click Print. 

Set up a Printer       

On the File menu, click Print Setup. The Print Setup dialog box appears. 

For help with setting up a printer, click  in the Print Setup dialog box. 

Exit the Program       

On the File menu, click Exit.  If you haven’t saved your data, you will be given a chance 
to do so. 

Take Distributions at the End of the Year 

By default, all fund activity takes place at the beginning of the year. This includes 
required minimum distributions and any additional distributions. If you prefer, you can 
have all fund distributions occur at the end of the year. 

On the Options menu, click Take Distributions at End of Year.  

View the Program in 16 Colors 

Though rarely necessary on today’s modern displays, if you would like to view the colors 
in 16 colors, click 16 Color Display. On the Options menu. 
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Chapter 3 
Calculating Minimum Distributions 

Minimum Distributions 

To calculate required minimum distributions, enter data on the main screen.  Most of 
these inputs are very straightforward, but here is a description of each one in case you 
have any questions. 

Note: By default, all fund activity takes place at the beginning of the year. 
This includes distributions and contributions. To have activity occur at the 
end of the year, click Take Distributions at End of Year  on the Options  
menu. 

 
Minimum Distributions Calculation: Table of Inputs 

 
Input  Description 

First Year of Analysis 

 
Enter the first year of the analysis. 

Type of Plan 

 
Select the type of qualified plan. For details on the types of 
plans that the program considers qualified, see the section later 
in this chapter.  
 

Year of First Required 
Distrib. 

If the Type of Plan is Normal, the program enters the Year of 
First Required Distrib. If the plan is a <5% Owner plan, 
enter the date of your client’s first required distribution in the 
Retirement box. 
 

12/31/(previous year) 
Balance 

Enter the value of all assets in the plan as of the end of the 
previous year. 
 

Expected Plan Growth Enter the expected annual percent increase of the plan. 
Is there a Designated 
Beneficiary? 

Select whether there is a designated beneficiary by clicking yes 
or no. 
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Owner’s Birth Date Enter the plan Owner’s Birth Date in month/day/year format. 
If an owner’s birth date is before 1917, the program displays a 
warning in the Hint Line . The minimum distributions rules for 
owners with birth dates prior to 1917 are more complex and 
may be different than the current rules. Therefore the program 
bases its calculations on minimum distributions rules after 
1917 (see Proposed Treas. Reg. Sec.1.408-8 for IRAs and 
1.401(a)(9) for Qualified Plans). 
 

Beneficiary’s Birth Date Enter the Beneficiary’s Birth Date in month/day/year format.  
The program uses the beneficiary’s birth date to determine 
joint life expectancy factors as well as a single life expectancy 
for the beneficiary.  See the expanded discussion below of 
beneficiaries. 

 
Minimum Distributions 
Options 

For distributions prior to 2001, additional calculation options 
were available. For more details about Minimum Distributions 
options, see Chapter 11, Reference Material. 
 

Assume Death Occurs Click Assume Death Occurs  and the Benef Info button to 
enter Assumed Dates of Death, Spousal Rollover, and multiple 
beneficiary information. 
Use this checkbox for Stretch IRAs, Inherited IRAs, spousal 
rollovers, Roth IRAs, and multiple beneficiaries. 
 

 

The two most common questions we receive about the software are how to illustrate a 
Stretch IRA and how to illustrate an Inherited IRA.  Handling both cases is really quite 
easy. 

Stretch IRAs 

The very popular "Stretch IRA" illustration simply illustrates the benefits to the heirs of 
proper planning.  By making the proper beneficiary designation, your client can ensure 
that his or her heirs receive lasting value from the IRA.  To show this in the software: 

1. Check the Assume Death Occurs  checkbox at the bottom of the inputs.  If you 
are illustrating a Roth IRA, this checkbox does not appear because it is assumed 
to be checked. 



Chapter 3: Calculating Minimum Distributions 

9 

2. Click the Benef. Info button to indicate when the owner and/or beneficiary die, 
and if there are multiple beneficiaries named.  

Inherited IRAs 

Inherited IRAs are those where the original owner has already passed away. In some 
cases, the original owner’s birth date is relevant to the calculation. Therefore, the 
program needs you to enter this information. To enter an Inherited IRA: 

1. Enter the birth date of the original owner (the one that has passed away) as the 
Owner’s Birth Date on the main input screen.  Enter the surviving beneficiary’s 
birth date as the Beneficiary’s Birth Date. 

2. Check the Assume Death Occurs  checkbox at the bottom of the inputs.  If you 
are illustrating a Roth IRA, this checkbox does not appear because it is assumed 
to be checked. 

3. Click the Benef. Info button to indicate when the owner and/or beneficiary die, 
and if there are multiple beneficiaries named.  For the Owner’s Death, uncheck 
the "Calculate" checkbox and enter the year the owner actually died.  It is okay to 
enter a year of death prior to the current year. 

Note: If your client is a surviving spouse and has rolled the IRA into 
his/her own IRA, there is no need to enter the original owner.  You 
can treat the surviving spouse as the owner of the plan. 

Beneficiary  

Under the final minimum distributions regulations, the specification of a beneficiary 
appears to be irrelevant.  It is not.  Always enter the actual beneficiary’s birth date, and 
indicate if the beneficiary is the spouse or not.  Generally, the term beneficiary refers to 
an individual.  

If a charity or the plan owner’s estate is named as the beneficiary, there is no “designated 
beneficiary,” and you should answer “No” to the question Is there a Designated 
Beneficiary?.   

A trust can also be named as the beneficiary. In such cases, there is often a “pass-
through” person, whose birth date should be entered as the Beneficiary’s birth date.  Note 
that trusts are generally not considered to be spouses.  If the trust does not meet the 
following rules, then there is no “pass-through” person: 

• Trusts must be valid under state law (or would be valid under state law if it had a 
trust corpus). 
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• Trusts must be irrevocable as of the participant’s death. 

• Trusts must benefit an individual or a specified class of individuals so that the life 
expectancy can be determined. 

• Trusts must be copied, and a copy must be given to the plan administrator by the 
required beginning date. 

 

Type of Plan 

The program calculates required minimum distributions for the following types of 
pension plans: 

• Corporate and self-employed pension, profit sharing and stock bonus plans 
qualified under IRC Sec. 401(a) (includes Keogh or H.R. 10 plans, 401(k) plans, 
and employee stock ownership plans or ESOPs), 

• Individual Retirement Accounts (IRAs) under IRC Sec. 408(a), 

• Simplified Employee Plans (SEPs) under IRC Sec. 408(k), and 

• Tax-sheltered annuities (except for account balances existing on 12/31/86 if kept 
separate for accounting purposes) under IRC Sec. 403(b). The Pension 
Distributions Planner classifies retirement plans into three groups. 

When calculating minimum distributions, you need to select a Type of Plan. Following     
are descriptions of the choices that the program provides. 

Normal 

This is the most common selection if the plan owner is retiring on or before age 70½, and 
the plan is not a Roth IRA. Use it for IRAs, 401(k)s, and Roth 401(k)s that are not rolled 
into Roth IRAs. 

Roth IRA 

The Roth IRA was created by the Taxpayer Relief Act of 1997. There are no required 
distributions until the year after the plan owner dies. The required beginning date of 
minimum distributions from a Roth IRA is the year after the owner’s death. At that point, 
the minimum distributions are calculated based on the beneficiary's single life 
expectancy. 

If the beneficiary is the Roth IRA owner’s spouse, the election to recalculate the 
beneficiary's single life expectancy each year after the required beginning date is 
available. For nonspousal beneficiaries, the life expectancy is calculated once and 
reduced by one for each year after the required beginning date. 
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Use this selection also for Roth 401(k)s if you are planning on rolling them to Roth IRAs 
when the owner retires. 

<5% Owner 

Use this selection if the owner is planning to retire after age 70½ and owns no more than 
5% of a company with a plan that is not an IRA. If the plan owner owns no more than 5% 
of a company with a pension plan that is not an IRA, the required minimum distributions 
are delayed until the retirement year. 
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Chapter 4 
Including Dates of Death and Spousal Rollovers 

 

 

Use the Beneficiary Info dialog box to handle the death of either the plan owner, the 
beneficiary, or both. Also, for cases in which the plan owner dies, you can indicate when 
a spousal rollover will occur. To enter dates of death and spousal rollovers, check the 
Assume Death Occurs  check box and the Benef. Info button in the Main window.  

For Roth IRAs, the Assume Death Occurs checkbox is checked automatically (and 
hidden).  In that case, just click the Beneficiary Info button. 

The Beneficiary Information window asks you a series of simple questions: 

Assume Owner Dies? 
Assume Beneficiary Dies? 
Assume Spouse Rollover? 
Does the Spouse Name a Beneficiary? 

The software only asks you those questions which are relevant to your case.  For 
example, if the beneficiary is not the spouse, it won’t ask you if there’s a spousal 
rollover. 

There is a checkbox next to each year input field on this window.  Check the box to have 
the software calculate the year.  Uncheck it to enter in your own year. 

Multiple Beneficiaries and Separate Accounts Rule  

You may not use separate life expectancies for multiple beneficiaries unless all of the 
beneficiaries are individuals and you have satisfied the separate accounts rule. If all of the 
beneficiaries are individuals, but the separate accounts rule has NOT been met, all of the 
beneficiaries must use the oldest beneficiary's life expectancy for required minimum 
distributions.  Under the regulations, a separate account “is a portion of an employee’s 
benefit determined by an acceptable separate accounting including allocating investment 
gains and losses, and contribut ions and forfeitures, on a pro rata basis in a reasonable and 
consistent manner between such portion and any other benefits.” 

If the plan is being split between multiple beneficiaries at death, enter their names, what 
percentage of the plan each receives, and their birth years. 
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The program allows you to illustrate multiple beneficiaries both using the Separate 
Accounts Rule and not using the Separate Accounts Rule.  Check the box labeled "Apply 
Separate Accounts Rule" to assume the Separate Accounts Rule is satisfied in the year 
after the death of the plan owner.  

Check the box labeled "Delay Separate Accounts 1 Year" to assume that the Separate 
Accounts Rule is satisfied, but not in time for the calculation of distributions in the year 
after death.  Checking this box causes the distributions in the year after death to be based 
on the life expectancy of the oldest beneficiary.  All subsequent years use the Separate 
Accounts Rule.  

The Delay Separate Accounts Rule is not relevant after 2004 – so the choice is not given 
if the year of death is after 2004. 

Note: Entering Multiple Beneficiaries is only possible in the Pension 
Distributions Planner. 

 

 



Chapter 5:  Calculating Pre-59½ Distributions 

15 

Chapter 5 
Calculating Pre-59½ Distributions 

Pre-59½ Distributions Calculator 

Note: Pre-59½ Distributions are only handled by the Pension 
Distributions Calculator and Pension Distributions Planner. 

Use the Pre-59½ Distributions Calculator to calculate the “substantially equal periodic 
payments” that plan owners need to make in order to avoid the 10% penalty for early 
distributions.  

To access the Pre-59 ½ Distributions Calculator, click Pre-59½ on the toolbar. The Pre-
59½ distributions screen shows only those inputs that are relevant to the current case. If 
the input is irrelevant to the case, the input field will disappear. Enter information in 
order (from top to bottom). 

If you would like to illustrate the Pre-59½ distributions as part of an overall illustration 
(along with the minimum distributions), check the box “Use Pre-59½ Distributions” at 
the bottom of the screen.  The pre-59½ distributions will be included in the summary of 
distributions  report.  It’s important to realize, however, that the summary of distributions 
report assumes all distributions happen annually – so the projected balances may differ 
from those on the pre-59½ distributions screen. 

 

Note: If you wish to have the progam fill in some of these inputs to give you a specific 
distribution amount, enter the Starting Date, Distribution Year, Distribution 
Frequency, Calculation Method, and Balance, and then click the Goal button on the 
bottom right hand corner of the window.  Answer the questions asked, and the software 
will calculate the rest of the inputs to get you the answers you’re looking for. 
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Pre-59½ Distributions Calculation: Table of Inputs 

 
Input  Description 

Starting Date Enter the first year that the plan owner needs the Pre-591/2 
Distribution. When the Distribution Frequency is Semiannual, 
Quarterly, or Monthly, the Starting Date determines the date of 
the pre-50 ½ distribution. 

 
Distribution Year For most cases, this input should be the same as the year of the 

Starting Date.  However, if your client started taking Pre-59½ 
Distributions in a previous year, you can use this input to 
calculate the distributions for the current year.  Set the Starting 
Date to be when Distributions started, and enter the current 
year as the Distribution Year. 

 
Distribution Method There are three methods for calculating early distributions: 

Minimum Distributions, Amortization, and Annuity Factor 
(see the IRS Notice 89-25 in Chapter 11, Reference Materials.)  

 

“Switch: Min. Distrib” should be used for clients who are 
already taking distributions and want to switch to the new 
minimum distribution method. It causes the distribution 
calculation to be based on the balance in the plan as of the 
point that the distributions begin (rather than the balance at the 
end of the previous year). 

 
Calculation Method 
 

After 2003, there are two choices for this input: “Rev. Rul. 
2002-62” and “Rev. Rul. 2002-62 FAQ”.  The “FAQ” 
methodology conforms to a “Frequently Asked Questions” list 
the IRS posted on their website, and generally results in higher 
distributions.  See “Revenue Rule 2002-62” in Chapter 11, 
Reference Materials, for more information.  Prior  to 2003, you 
have more options, including IRS Notice 89-25 and Ltr Ruling.  
These are all methodologies that were available prior to 2003, 
and are not available to distributions beginning after that. 
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Recalculate Each Year 
(PLR)? 
 

Several Private Letter Rulings (PLRs) have indicated that 
distribution amounts can be recalculated each year (even for 
the Annuitization and Amortization methods).  If you wish to 
follow this methodology, answer Yes to this question.  A 
disclaimer will appear on the reports whenever you answer 
yes to this question. 

 
Plan Balance 
 

Enter the value of all assets in the plan. The Minimum 
Distributions rules require that you enter the balance of the 
plan as of December 31 of the year preceding the first year of 
analysis. After the first year, the Private Letter Rulings also use 
the 12/31 plan balance to calculate distributions. This input is 
enabled only when it is relevant to the calculations. When Rev. 
Rule 2002-62 applies, the minimum distributions method is 
calculated using the balance as of the first distribution in each 
year.  

 
Expected Plan Growth Enter the expected annual growth of the plan. This rate is not 

used to calculate distributions. It is just used for projections. 

 
Distribution Frequency 
 

Select a Distribution Frequency. Plan owners can make pre-
59½ distributions Annually, Semiannual, Quarterly, or 
Monthly. Depending on the Distribution Frequency, the Plan 
Balance is calculated differently. For example, if the 
Distribution Frequency is Annual, the growth is compounded 
only once each year. If it is Semiannual, compounding occurs 
twice.  

 
Joint/Single Life Exp 
 

Select whether to base the calculation of distributions on a 
single or a joint life expectancy. 

 
Birth Dates 
 

Enter the owner’s birth date and the beneficiary’s birth date in 
month/day/year format. The beneficiary’s birth date is used to 
determine joint life expectancy factors. 
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Use Maximum Interest 
Rate 
 

Rev. Rul. 2002-62 defines the maximum “reasonable interest 
rate” to be the highest applicable federal midterm rate of the 
two months prior to the first distribution.  Answering yes to 
this question causes the program to fill in the “reasonable 
interest rate” automatically, disabling that input field. If the 
federal midterm rate has not been entered, the "Use Maximum 
Interest Rate" input is set to “No.” 

 
“Reasonable” Interest 
Rate: 
 

A “Reasonable” Interest Rate (see below for more information) 
is needed for the Annuity Factor or Amortization methods. 

These rates are posted on Brentmark’s web site, 
http://www.brentmark.com. 

 
Use Uniform Life Table 
 

If the owner is still alive, the life expectancy is taken straight 
from the Uniform Lifetime Table. Simply find the owner’s age 
on the table (it covers ages 70 through 115), and use the life 
expectancy listed. For this situation, the only change caused by 
the 2002 final regulations was to update the numbers in the 
Uniform Lifetime Table. 

 
Annuity Factor Table 
 

Prior to the Final Regulations, there were a variety of mortality 
tables available.  If this input appears, see Chapter 11, 
Reference Material for information on the different annuity 
factor tables available. 

Reasonable Interest Rate 

A so-called “reasonable” interest rate is required when using the Amortization or Annuity 
Factor methods to compute a pre-59½ plan distribution that avoids the 10% penalty for 
early distributions. The program limits you to entering a rate no higher than the highest 
AFR of the two months prior to the first distribution. 

Prior to 2002, see IRS Notice 89-25, 1989-1 C.B. 662, Q&A 11 and 12. In various letter 
rulings, the IRS has accepted use of the 120% Annual Long-Term Applicable Federal 
Rate for the month in which distributions start. Some commentators read some of the 
rulings as saying that you should use 120% of the Annual Long-Term Rate, which is 
slightly different. However, the difference may be seen as de minimus. If you judge this 
rate to be appropriate, it may be used in the Pension Distributions Planner. Letter Rulings 
cannot be used as binding authority for IRS positions. Since the IRS has not issued any 
rulings other than Letter Rulings on the topic of "reasonable" interest rates for pre-59½ 
distributions, there is no binding authority on this topic. 
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Chapter 6 
Including Contributions & Additional Distributions  

Contributions 

Use the Enter Contributions to the Qualified Plan dialog box to enter contributions to 
an analysis. For example, many employers contribute to employee retirement funds. To 
enter contributions, click the Specify Contributions button in the Main window. 

Contributions are added just after distribution amounts are withdrawn. If distributions are 
taken at the end of the year, contributions occur then. If distributions are taken at the 
beginning of the year, contributions occur at the beginning of the year. 

Note: Generally, additional contributions cannot be made after the 
required beginning date. 

When entering contributions, you can enter up to 5 different streams of contributions.  On 
each different line, enter the annual amount contributed, the annual increase in that 
contribution amount, the first year the contribution is made and the last year the 
contribution is made. 

For example, assume that your clients wants to contribute $10,000 a year, increasing by 
3% each year from 2005 through 2010. Additionally, they are planning a one-time 
contribution of $20,000 in 2010. 
 

 Annual Amount Growth Rate First Year Last Year 
1. $10,000 3.00% 2005 2010 
2. $20,000 0% 2010 2010 

In 2010, the contribution amount will be $31,592 ($10,000 increased by 3% a year plus 
$20,000).  

Distributions 

Use the Enter Desired Plan Distributions dialog box to enter desired distributions to an 
analysis. For example, your clients might want to make distributions to buy insurance or 
for living expenses.  

By default, all fund activity takes place at the beginning of the year. This includes 
required minimum distributions and any additional distributions. To make all fund 
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distributions occur at the end of the year, on the Options  menu, click Take Distributions 
at End of Year. 

To enter distributions, click the Specify Distributions  button in the Main window. 

Note:  Whenever desired distributions are less than the required minimum 
distribution, the program will distribute the minimum required amount. 

When entering distributions, you can enter up to 5 different streams of distributions.  On 
each different line, enter the annual amount needed, the annual increase in that amount, 
the first year the distribution will be made and the last year the distribution will be made. 

For example, assume that your clients wants to $10,000 a year, increasing by 3% each 
year from 2005 through 2010. Additionally, they are planning to buy a $30,000 car in 
2010.  
 

 Annual Amount Growth Rate First Year Last Year 
1. $10,000 3.00% 2005 2010 
2. $30,000 0% 2010 2010 

In 2010, the distribution amount will be $41,592 ($10,000 increased by 3% a year plus 
$30,000).  Remember that if the required minimum distribution is higher than this, the 
minimum will be distributed. 
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Chapter 7 
Viewing Results 

Reports 

The program offers several reports (and graphs) that can be printed: 

1. The Distributions Summary shows the projection of distributions and balances.  
The age column of this report shows the owner’s age until the assumed death, 
after which it shows the beneficiary’s age.  The Life Expectancy shows the 
person’s single life expectancy until the required minimum distributions begin.  
During required minimum distributions, the Life Expectancy column lists the 
divisor necessary for calculating the distribution amount. 

2. The Beneficiaries Report:  illustrates the distributions going to each beneficiary.  
It is only available in the Pension Distributions Planner. 

3. The 2006 Minimum Distribution Report shows calculated distribution for the 
entered First Year of Analysis.  It contains no growth projections, and is 
appropriate for reporting a client’s minimum distribution requirement. 

4. The Distributions Graph  is a line graph showing the projected distributions. 

5. The Plan Balance Graph  is a bar chart showing the projected balance and total 
distributions. 

6. The Pre-59½ Distributions Report: 2006 shows the calculated pre-59½ 
distribution amount for the entered Distribution Year. It is appropriate for 
reporting a clients 72(t) distribution (not available in the Minimum 
Distributions Calculator). 

7. The Pre-59½ Distributions Report illustrates the projected 72(t) distributions for 
the selected distribution method (not available in the Minimum Distributions 
Calculator). 

8. Pre-59½ Comparison Report illustrates the difference between the different 72(t) 
distribution methods (not available in the Minimum Distributions Calculator). 
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Chapter 8 
Printing Reports & Graphs 

 

Print Report Window  

Use the Print Report window to select reports and graphs for printing and to select 
printing options (for more printing options, see Report Options  window). Also from the 
Print Report window, you can save a report as a Text or Spreadsheet file. Before printing, 
be sure that your printer is set up and that you’ve formatted your printed reports in the 
Report Options window. 

There are three ways to call up the print window:  
1. On the Toolbar, click the Print graphic. 
2. On the File menu, click Print. 
3. In the Pre 59½ Distributions window, click the Print button. 

 
On the Print Report window, select which reports you’d like to print.  See Chapter  7 for 
a discussion of the different reports available.  Once you’ve selected the reports and 
graphs to print, click one or more of the the buttons: 
 
Print Report:  Prints the reports to the printer displayed on the bottom of the Print 

Report window. 
Print Preview:  Previews the reports exactly as they will print.  Use the Zoom button to 

magnify the view. 
Print to File:  Prints the report to a file, suitable for editing, e-mailing, or viewing.  

Select the type of file you’d like to create and then click Create and Open to 
create the file and open it up. Note that files created by Print to File cannot be 
loaded by the Pension Distributions Planner. 

Printer Setup:  Lets you specify a different printer, or set your printer’s options 
(landscape/portrait, color options, etc.) before printing. 

Report Options:  Calls up the Report Options window which allows you to customize 
the reports in many different ways, including fonts, printer margins, report 
headings, and much more. 
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Chapter 9  
Formatting Reports 

Report Options Window       

Use the Report Options window to format your reports and graphs for printing. The 
Report Options window allows you to create headings, format text and layout, and 
include other options for printing. All report options are automatically saved, so the next 
time you run the program, you don’t have to reformat your reports. 

To access the Report Options window, either select Report Options from the Options 
menu or click the Report Options button on the Print Window. 

The Report Options window lets you customize your reports in the following ways: 

Create a Heading for a Report  

In the box labeled Heading, type the text that you’d like to have displayed at the top of 
each page of your printed report.  Many users add two lines: “Report Prepared By”, and 
“Report Prepared For”. 

Page Margin  

Under the Page Margins  heading in the Report Options window, enter the Top, Bottom, 
Left, and Right page margins (in inches). 

Change Fonts  

Under the Fonts heading in the Report Options window, click the text you want to 
format. The Font dialog box appears.  Select the Font, Style, Size , and Effects to apply 
to the text and click OK.  Notice that the description of the text in the Report Options 
window has changed. 

Other Printing Options  NT       

There are several other different ways that you can customize your reports.  Just check 
(or uncheck) the boxes as you see fit: 

Print in Black and White: Forces the printouts to only print in black and white 

Print Page Numbers: Prints page numbers at the bottom of each page 



Pension Distributions Planner 

26 

Print Date: Prints the current date on the top right of each page. 

Print Time:  Prints the current time on the top right of each page. 

Total Report Columns:  Prints a total at the bottom of each report column 

Track Accumulated Distributions: Adds a column tracking total distributions 
made as of each year. 

NT-Style Printing: Lets you switch between two different modes of printing. 
only change this setting if the reports are not printing properly. 

 



Getting Help 

27 

Chapter 10 
Getting Help 

 

If you need help, it’s easy to find. Click the question mark wherever it appears in the 
program and a Help topic appears for the window in which you are working.  You can 
also use the Help menu to quickly access common help topics. If you still need help, see 
the technical support section below. 

Help Menu 

Use the Help menu to access the Help system, learn how to use Help, or view 
information about this product and other Brentmark products.  

Help System 

The program provides a complete Help system, so you can get help whenever you need 
it. Just click the question mark that appears in the top right corner of every data entry 
section. Use the Help system’s table of contents to view Help topics by category or 
search the Help index for specific terms. 

Technical Support 

For technical support, contact us at (407) 306-6160, or send an e-mail to 
support@brentmark.com.  We’re also available online at www.brentmark.com. 
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Chapter 11 
Reference Material 

This is a collection of articles and revenue rulings which you may find helpful when 
doing calculations. 

Minimum Distributions Calculations   

Required Minimum Distributions: 
Calculations under the Final Regulations  

After more than a decade of proposed regulations, final minimum distribution regulations 
were published on April 17, 2002. These new rules are based primarily on the proposed 
regulations of 2001, but they do add some new calculation wrinkles to consider. 

As with the 2001 proposed regulations, the final regulations keep the basic calculation 
intact. Each year, the distribution is calculated by dividing the previous year’s ending 
balance by a life expectancy number. The calculation complexity lies in determining the 
life expectancy number.  

Here’s how the new rules work: 

Situation I: Owner still alive 
If the owner is still alive, the life expectancy is taken straight from the Uniform Lifetime 
Table. Simply find the owner’s age on the table (it covers ages 70 through 115), and use 
the life expectancy listed. For this situation, the only change caused by the 2002 final 
regulations was to update the numbers in the Uniform Lifetime Table. 

Prior to 2001, the Uniform Lifetime Table was known as the MDIB table, and was used 
only for nonspousal beneficiaries. Now, it is used whenever the owner is alive, making 
the distribution calculation very straightforward. There is only one exception to this rule: 
cases involving spousal beneficiaries who are more than ten years younger than the 
owner. In that case, the joint life expectancy of the owner and spouse is used. Once the 
owner dies, this exception no longer applies, and Situation 4 (see below) applies. 

Situation 2: Owner dies with no beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 

If the owner dies before the required beginning date, and there is no beneficiary alive as 
of the owner’s death, the five year rule applies—all the money has to be distributed 
within five years of the year the owner died. 
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If the owner dies on or after the required beginning date, and there is no beneficiary alive 
as of the date of death, distributions after the owner’s death are taken over a term based 
on the owner’s life expectancy in the year of death. This calculation is easier than it 
sounds. For the year after death, subtract one from the owner’s single life expectancy in 
the year of death. As each year passes, reduce the life expectancy by one. For example, if 
the owner died in 2003, the distribution in 2004 would be based on the owner’s 2003 life 
expectancy minus one. 

The new life expectancy tables used by the 2002 final regulations add some complexity 
to cases where the owner has already died. If distributions are being taken under this 
scenario, the length of the term has to be recalculated using the 2002 single life 
expectancy table. For example, if a plan owner died in 1995, the 2003 distribution would 
be based on the owner’s life expectancy (using the new table) in 1995 reduced by 8. 

Under the 2001 proposed regulations, the beneficiary had to be alive as of 12/31 of the 
year following the owner’s death to be considered valid. Under the 2002 regulations, the 
beneficiary only has to be alive when the owner dies to be considered.  

Situation 3: Owner dies with nonspousal beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 

When the owner dies with a nonspousal beneficiary, a term certain distribution period is 
established based on the designated beneficiary’s single life expectancy in the year after 
the owner’s death. Unlike Situation 2, in this case the term is based on a life expectancy 
calculated in the year after the owner’s death, rather than the year of death. For example, 
if the owner died in 2003, the life expectancy used as the divisor in 2004 would be the 
beneficiary’s single life expectancy in 2004. In 2005, the divisor used would be 2004’s 
number minus 1. The life expectancy in the year after death is, of course, calculated using 
the new single life expectancy table, and, as with Situation 2, an existing term certain 
would have to be recalculated using the new table. 

The 2002 final regulations add another wrinkle to those situations when the owner died 
on or after the required beginning date. In these situations, the life expectancy used is the 
greater of the one calculated using the “no beneficiary” case (situation 2), and the one 
resulting from the calculation described in the previous paragraph. This can get a little 
confusing, because the “no beneficiary” case starts with a term calculated in the year of 
death, while the nonspousal beneficiary’s term certain starts the year after the owner’s 
death. 

Situation 4: Owner dies with spousal beneficiary 
In the year of death, the minimum distribution is still calculated according to Situation 1 
(above). It’s only in the years after the owner’s death that this situation applies. 

When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this 
case, the distributions are based on the spouse’s single life expectancy recalculated each 
year after the owner’s death. If the owner dies prior to the calendar year in which he 
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would have reached age 70½, the spouse does not have to start taking distributions until 
that year. Upon the spouse’s death, the distributions become term certain, with the term 
set to the spouse’s life expectancy in the year of death. This works the same as the old 
term certain method, with the life expectancy being reduced by one for each year that 
passes after the spouse’s death. 

As with situation 3, the 2002 final regulations add more complexity. For cases where the 
client dies on or after the required beginning date, the life expectancy used is the greater 
of the one calculated using the “no beneficiary” case (situation 2), and the one resulting 
from the calculation described in the previous paragraph. 

When do these apply? 

In 2002, there is the option of using either the pre-2001 proposed regulations (with all 
their calculation and recalculation options), the 2001 proposed regulations, and the 2002 
final regulations. After 2002, only the 2002 final regulations may be used.  

The 2002 final regulations added more than just a new mortality table to these 
calculations. They also added complexity. When all the different situations listed above 
are taken together, they represent a fairly complicated set of calculations that have to be 
correctly performed to make sure you calculate the correct distribution for your clients.  

 2002, Brentmark Software, Inc. All Rights Reserved. 
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Rev. Rul. 2002-62; 2002-42 IRB 1 (3 Oct 2002) 

Part I  

Section 72.--Annuities; Certain Proceeds of Endowment and Life Insurance Contracts 

SECTION 1.  PURPOSE AND BACKGROUND  

.01   The purpose of this revenue ruling is to modify the provisions of Q&A-12 of Notice 
89-25, 1989-1 C.B. 662, which provides guidance on what constitutes a series of 
substantially equal periodic payments within the meaning of § 72(t)(2)(A)(iv) of the 
Internal Revenue Code from an individual account under a qualified retirement plan. 
Section 72(t) provides for an additional income tax on early withdrawals from qualified 
retirement plans (as defined in § 4974(c)).   Section 4974(c) provides, in part, that the 
term “qualified retirement plan” means (1) a plan described in § 401 (including a trust 
exempt from tax under § 501(a)), (2) an annuity plan described in § 403(a), (3) a tax-
sheltered annuity arrangement described in § 403(b), (4) an individual retirement account 
described in § 408(a), or (5) an individual retirement annuity described in § 408(b).  

.02  (a)  Section 72(t)(1) provides that if an employee or IRA owner receives any amount 
from a qualified retirement plan before attaining age 59½, the employee’s or IRA 
owner’s income tax is increased by an amount equal to 10-percent of the amount that is 
includible in the gross income unless one of the exceptions in § 72(t)(2) applies.       

(b)  Section 72(t)(2)(A)(iv) provides, in part, that if distributions are part of a series of 
substantially equal periodic payments (not less frequently than annually) made for the life 
(or life expectancy) of the employee or the joint lives (or joint life expectancy) of the 
employee and beneficiary, the tax described in § 72(t)(1) will not be applicable.  Pursuant 
to § 72(t)(5), in the case of distributions from an IRA, the IRA owner is substituted for 
the employee for purposes of applying this exception.   

(c) Section 72(t)(4) provides that if the series of substantially equal periodic payments 
that is otherwise excepted from the 10-percent tax is subsequently modified (other than 
by reason of death or disability) within a 5-year period beginning on the date of the first 
payment, or, if later, age 59½, the exception to the 10-percent tax does not apply, and the 
taxpayer’s tax for the year of modification shall be increased by an amount which, but for 
the exception, would have been imposed, plus interest for the deferral period. 

 (d)  Q&A-12 of Notice 89-25 sets forth three methods for determining whether payments 
to individuals from their IRAs or, if they have separated from service, from their 
qualified retirement plans constitute a series of substantially equal periodic payments for 
purposes of § 72(t)(2)(A)(iv).   
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(e)  Final Income Tax Regulations that were published in the April 17, 2002, issue of the 
Federal Register under § 401(a)(9) provide new life expectancy tables for determining 
required minimum distributions. 

SECTION 2.   METHODS 

.01  General rule.  Payments are considered to be substantially equal periodic payments 
within the meaning of § 72(t)(2)(A)(iv) if they are made in accordance with one of the 
three calculations described in paragraphs (a) – (c) of this subsection (which is comprised 
of the three methods described in Q&A-12 of Notice 89-25).  

(a)  The required minimum distribution method.  The annual payment for each year is 
determined by dividing the account balance for that year by the number from the chosen 
life expectancy table for that year.  Under this method, the account balance, the number 
from the chosen life expectancy table and the resulting annual payments are redetermined 
for each year.  If this method is chosen, there will not be deemed to be a modification in 
the series of substantially equal periodic payments, even if the amount of payments 
changes from year to year, provided there is not a change to another method of 
determining the payments. 

 (b) The fixed amortization method.  The annual payment for each year is determined by 
amortizing in level amounts the account balance over a specified number of years 
determined using the chosen life expectancy table and the chosen interest rate.  Under 
this method, the account balance, the number from the chosen life expectancy table and 
the resulting annual payment are determined once for the first distribution year and the 
annual payment is the same amount in each succeeding year.  

 (c) The fixed annuitization method.  The annual payment for each year is determined by 
dividing the account balance by an annuity factor that is the present value of an annuity 
of $1 per year beginning at the taxpayer's age and continuing for the life of the taxpayer 
(or the joint lives of the individual and beneficiary).  The annuity factor is derived using 
the mortality table in Appendix B and using the chosen interest rate.  Under this method, 
the account balance, the annuity factor, the chosen interest rate and the resulting annual 
payment are determined once for the first distribution year and the annual payment is the 
same amount in each succeeding year.                   

.02  Other rules.   The following rules apply for purposes of this section.   

(a)  Life expectancy tables.  The life expectancy tables that can be used to determine 
distribution periods are: (1) the uniform lifetime table in Appendix A, or (2) the single 
life expectancy table in § 1.401(a)(9)-9, Q&A-1 of the Income Tax Regulations or (3) the 
joint and last survivor table in § 1.401(a)(9)-9, Q&A-3. The number that is used for a 
distribution year is the number shown from the table for the employee’s (or IRA owner’s) 
age on his or her birthday in that year.  If the joint and survivor table is being used, the 
age of the beneficiary on the beneficiary’s birthday in the year is also used.  In the case of 
the required minimum distribution method, the same life expectancy table that is used for 
the first distribution year must be used in each following year.  Thus, if the taxpayer uses 
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the single life expectancy table for the required minimum distribution method in the first 
distribution year, the same table must be used in subsequent distribution years. 

(b)  Beneficiary under joint tables.  If the joint life and last survivor table in §1.401(a)(9)-
9, Q&A-3, is used, the survivor must be the actual beneficiary of the employee with 
respect to the account for the year of the distribution. If there is more than one 
beneficiary, the identity and age of the beneficiary used for purposes of each of the   
methods described in section 2.01 are determined under the rules for determining the 
designated beneficiary for purposes of § 401(a)(9).  The beneficiary is determined for a 
year as of January 1 of the year, without regard to changes in the beneficiary in that year 
or beneficiary determinations in prior years.  For example, if a taxpayer starts 
distributions from an IRA in 2003 at age 50 and a 25-year-old and 55-year-old are 
beneficiaries on January 1, the 55-year-old is the designated beneficiary and the number 
for the taxpayer from the joint and last survivor tables (age 50 and age 55) would be 38.3, 
even though later in 2003 the 55-year-old is eliminated as a beneficiary.  However, if that 
beneficiary is eliminated or dies in 2003, under the required minimum distribution 
method, that individual would not be taken into account in future years.  If, in any year 
there is no beneficiary, the single life expectancy table is used for that year.  

(c)   Interest rates.  The interest rate that may be used is any interest rate that is not more 
than 120 percent of the federal mid-term rate (determined in accordance with § 1274(d) 
for either of the two months immediately preceding the month in which the distribution 
begins).  The revenue rulings that contain the § 1274(d) federal mid-term rates may be 
found at www.irs.gov\tax_regs \fedrates.html.  

(d)  Account balance. The account balance that is used to determine payments must be 
determined in a reasonable manner based on the facts and circumstances.  For example, 
for an IRA with daily valuations that made its first distribution on July 15, 2003, it would 
be reasonable to determine the yearly account balance when using the required minimum 
distribution method based on the value of the IRA from December 31, 2002 to July 15, 
2003.  For subsequent years, under the required minimum distribution method, it would 
be reasonable to use the value either on the December 31 of the prior year or on a date 
within a reasonable period before that year’s distribution.  

(e)  Changes to account balance.  Under all three methods, substantially equal periodic 
payments are calculated with respect to an account balance as of the first valuation date 
selected in paragraph (d) above.  Thus, a modification to the series of payments will 
occur if, after such date, there is (i) any addition to the account balance other than gains 
or losses, (ii) any nontaxable transfer of a portion of the account balance to another 
retirement plan, or (iii) a rollover by the taxpayer of the amount received resulting in such 
amount not being taxable.  

.03 Special rules.  The special rules described below may be applicable.   

(a) Complete depletion of assets.   If, as a result of following an acceptable method of 
determining substantially equal periodic payments, an individual’s assets in an individual 
account plan or an IRA are exhausted, the individual will not be subject to additional 
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income tax under § 72(t)(1) as a result of not receiving substantially equal periodic 
payments and the resulting cessation of payments will not be treated as a modification of 
the series of payments.    

(b) One-time change to required minimum distribution method.   An individual who 
begins distributions in a year using either the fixed amortization method or the fixed 
annuitization method may in any subsequent year switch to the required minimum 
distribution method to determine the payment for the year of the switch and all 
subsequent years and the change in method will not be treated as a modification within 
the meaning of § 72(t)(4).  Once a change is made under this paragraph, the required 
minimum distribution method must be followed in all subsequent years.   Any subsequent 
change will be a modification for purposes of § 72(t)(4). 

SECTION 3.  EFFECTIVE DATE AND TRANSITIONAL RULES       

 The guidance in this revenue ruling replaces the guidance in Q&A-12 of Notice 
89-25 for any series of payments commencing on or after January 1, 2003, and may be 
used for distributions commencing in 2002.   If a series of payments commenced in a 
year prior to 2003 that satisfied § 72(t)(2)(A)(iv), the method of calculating the payments 
in the series is permitted to be changed at any time to the required minimum distribution 
method described in section 2.01(a) of this guidance, including use of a different life 
expectancy table.  

SECTION 4. EFFECT ON OTHER DOCUMENTS 

Q&A-12 of Notice 89-25 is modified.   

SECTION 5. REQUEST FOR COMMENTS 

The Service and Treasury invite comments with respect to the guidance provided in this 
revenue ruling.   Comments should reference Rev. Rul. 2002-62.   

Comments may be submitted to CC:ITA:RU (Rev. Rul. 2002-62, room 5226, Internal 
Revenue Service, POB 7604 Ben Franklin Station, Washington, DC 20044.  Comments 
may be hand delivered between the hours of 8:30 a.m. and 5 p.m. Monday to Friday to: 
CC:ITA:RU (Rev. Rul. 2002-62), Courier's Desk, Internal Revenue Service, 1111 
Constitution Avenue NW., Washington, D.C.  Alternatively, comments may be submitted 
via the Internet at Notice.Comments@irscounsel.treas.gov.  All comments will be 
available for public inspection and copying. 

Drafting Information  

 The principal author of this revenue ruling is Michael Rubin of the Employee 
Plans, Tax Exempt and Government Entities Division.  For further information regarding 
this revenue ruling, please contact Mr. Rubin at 1-202-283-9888 (not a toll- free number).  
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Discussion of Revenue Ruling 2002-62 

Revenue Ruling 2002-62 is more than just a minor refinement of the way substantially 
equal periodic payments are calculated. It has made significant changes to all three 
method and clarifies some previously questionable areas. Unfortunately, it still leaves a 
lot of gray areas. 

As a brief refresher, IRS Notice 89-25 established three ways of calculating 
“substantially equal periodic payments” to avoid the 10% penalty on early withdrawals 
from qualified retirement plans. Rev. Rul. 2002-62 replaces the guidance of IRS Notice 
89-25. 

The first of the three methods, “the required minimum distribution method,” allows for 
distributions to be calculated in the same manner that minimum distributions are 
calculated. Since these distributions are almost always calculated using the Uniform 
Lifetime Table, the Revenue Ruling extended the beginning of this table to include all 
ages from 10 through 115. The single life expectancy table and joint life expectancy 
tables may still be used as well. The calculation is the same as it was prior to the ruling, 
requiring the distribution to be recalculated each year based on the life expectancy, but 
now the Uniform Lifetime Table is available in addition to the single and joint life 
expectancy tables. It’s worth noting that once a life expectancy table is selected, it must 
be used for the duration of the distributions. 

The second of the three methods, “the fixed amortization method,” has been little 
changed by the ruling. The distribution amount is still calculated just once, based on 
amortizing the plan balance over the applicable life expectancy. The only change the 
Revenue Ruling made was to give the plan owner the choice of three life expectancy 
tables: single, joint, or the Uniform Lifetime Table. 

The third of the three methods, “the fixed annuitization method,” requires the 
distributions to be calculated through the use of an annuity factor. Prior to Revenue 
Ruling 2002-62, this annuity factor had to be calculated from a “reasonable mortality 
table.” Now, only the mortality table from the Ruling can be used. As with the 
amortization method, the distribution is calculated only once and that distribution amount 
is used throughout the distribution period. 

These three methods are all basically the same as they were previously, with slightly 
different details to the calculations. The biggest change implemented by Revenue Ruling 
2002-62 came in the form of a clarification. Previously, the “reasonable interest rate” 
required by IRS Notice 89-25 was generally assumed to mean the 120% annual long-term 
rate. The Ruling establishes that the 120% federal mid-term interest rate is the maximum 
allowable interest rate for the calculation. Decreasing the allowable rate by that much (in 
October 2002, a difference of 1.73%) significantly decreases the distributions allowed 
under the amortization and annuitization distribution methods.  
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Revenue Ruling 2002-62 also eliminated the possibility of recalculating distributions 
when using either the amortization or annuitization distribution methods. Recalculating 
these distributions had started to become popular after it was allowed in a couple letter 
rulings, but the Rev. Rul. 2002-62 makes it clear that only the minimum distribution 
method can be recalculated. It does allow for plan owners to switch to that method, 
allowing some relief for people whose plans are losing money. 

Another interesting change made by the Revenue Ruling is that distributions must now be 
calculated for distributions that are occurring right away. The Ruling sets the maximum 
allowable interest rate to be the higher of the mid-term rates from the two months prior to 
the first distribution. Obviously, this means that we cannot do a calculation in 2002 for a 
2003 distribution, because there’s no way to know what the maximum rate is.  

Unfortunately, Revenue Ruling 2002-62 speaks only in terms of annual distributions. It 
does nothing to clear up the question of distributions that are taken more frequently than 
annual. Should monthly distributions be calculated by just dividing the annual 
distribution by 12? Maybe. Annuity factors typically account for frequency of 
distributions, so it would seem that the calculation of the distribution amount under the 
annuitization method should do so. Amortization schedules always account for frequency 
of payments as well: paying a mortgage monthly versus paying it annually results in a 
different annual payment amount. Of the three methods, the minimum distributions 
method seems like the only one where the frequency of distributions would have no 
affect on the annual distribution amount. Revenue Ruling 2002-62 does not address this 
issue at all, however. 
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IRS Notice 89-25 

Excerpts from IRS Notice 89-25, 1989-1 C.B. 662 

Q-11: Does the 10-percent tax under section 72(t) apply to amounts that are included in a 
plan participant’s gross income pursuant to section 72(m)(3)? 

A-11: No. Section 72(m)(3) provides generally that employer contributions and trust 
income that are treated under regulations as having been applied to the purchase of life 
insurance protection for a plan participant must be included in the participant's gross 
income.  However, such an amount is not treated as a distribution for purposes of section 
72(t). 

Q-12: In the case of an IRA or individual account plan, what constitutes a series of 
substantially equal periodic payments for purposes of section 72(t)(2)(A)(iv)? 

A-12: Section 72(t)(1) imposes an additional tax of 10 percent on the portion of early 
distributions from qualified retirement plans (including IRAs) includable in gross 
income. However, section 72(t)(2)(A)(iv) provides that this tax shall not apply to 
distributions which are part of a series of substantially equal periodic payments (not less 
frequently than annually) made for the life (or life expectancy) of the employee or the 
joint lives (or joint life expectancies) of the employee and beneficiary. Section 72(t)(4) 
provides that, if the series of periodic payments is subsequently modified within five 
years of the date of the first payment, or, if later, age 59½, the exception to the 10 percent 
tax under section 72(t)(2)(A)(iv) does not apply, and the taxpayer’s tax for the year of 
modification shall be increased by an amount, determined under regulations, which (but 
for the 72(t)(2)(A)(iv) exception) would have been imposed, plus interest. 

Payments will be considered to be substantially equal periodic payments within the 
meaning of section 72(t)(2)(A)(iv) if they are made according to one of the methods set 
forth below. 

Payments shall be treated as satisfying section 72(t)(2)(A)(iv) if the annual payment is 
determined using a method that would be acceptable for purposes of calculating the 
minimum distribution required under section 401(a)(9). For this purpose, the payment 
may be determined based on the life expectancy of the employee or the joint life and last 
survivor expectancy of the employee and beneficiary. 

Payments will also be treated as substantially equal periodic payments within the 
meaning of section 72(t)(2)(A)(iv) if the amount to be distributed annually is determined 
by amortizing the taxpayer's account balance over a number of years equal to the life 
expectancy of the account owner or the joint life and last survivor expectancy of the 
account owner and beneficiary (with life expectancies determined in accordance with 
proposed section 1.401(a)(9)-1 of the regulations) at an interest rate that does not exceed 
a reasonable interest rate on the date payments commence. For example, a 50 year old 
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individual with a life expectancy of 33.1, having an account balance of $100,000, and 
assuming an interest rate of 8 percent, could satisfy section 72(t)(2)(A)(iv) by distributing 
$8,679 annually, derived by amortizing $100,000 over 33.1 years at 8 percent interest. 

Finally, payments will be treated as substantially equal periodic payments if the amount 
to be distributed annually is determined by dividing the taxpayer's account balance by an 
annuity factor (the present value of an annuity of $1 per year beginning at the taxpayer's 
age attained in the first distribution year and continuing for the life of the taxpayer) with 
such annuity factor derived using a reasonable mortality table and using an interest rate 
that does not exceed a reasonable interest rate on the date payments commence. If 
substantially equal monthly payments are being determined the taxpayer's account 
balance would be divided by an annuity factor equal to the present value of an annuity of 
$1 per month beginning at the taxpayer's age attained in the first distribution year and 
continuing for the life of the taxpayer. For example, if the annuity factor for a $1 per year 
annuity for an individual who is 50 years old is 11.109 (assuming an interest rate of 8 
percent and using the UP-1984 Mortality Table), an individual with a $100,000 account 
balance would receive an annual distribution of $9,002 ($100,000/11.109 = $9,002). 
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Minimum Distribution Incidental Benefit (MDIB) 
(Only applicable before 2002) 

Non-spousal distributions will be subjected to the Minimum Distribution Incidental 
Benefit (MDIB) requirement (see IRC Proposed Treas. Reg. §1.401(A)(9)-2). The MDIB 
requirement states that any distribution occurring after the required beginning date must 
be less than the distribution that was calculated by dividing the balance of the plan by the 
MDIB Table divisor found in IRC Proposed Treas. Reg. §1.401 (a)(9)-2, Q-4. Generally, 
when the non-spousal beneficiary is more than ten years younger than the plan owner, the 
MDIB is triggered and results in a joint life expectancy factor, regardless of the actual 
age of the non-spousal beneficiary. Thus, during the lifetime of the plan owner but after 
the plan owner reaches age 70½, there is no difference in the minimum distribution 
payout amount, regardless of whether the non-spousal beneficiary is 15 or 30 years 
younger than the plan owner is. 

The program always removes the MDIB limitation after the plan owner’s death. 
Authority for Removal of MDIB after the death of the plan owner is found in IRS 
Publication 590 and IRC Proposed Treas. Reg. §1.401(a)(9)-2, Q&A Q-3. If the owner 
made an appropriate election before the required beginning date, a joint term certain 
method will be used after the plan owner’s death (rather than just a single life term 
certain for the beneficiary in cases where the owner was using a recalc method). 
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Calculating Required Minimum Distributions using the 2001 Proposed 
Regulations:  

The regulations released on 1/11/2001 radically changed the way minimum distributions 
have to be calculated. They eliminated a lot of complexity reduced the number of 
decisions made by a plan owner. These regulations eliminated the old recalculation 
options. There is no "hybrid method" or "joint term certain method." However, the new 
methodology does still have some similarities to the old. For example, the distribution is 
still calculated by dividing the previous year's balance by a life expectancy number. 

Here’s how it works: 

Situation 1: Owner still alive 

If the owner is still alive, the distributions are based on the divisor found in the MDIB 
table for owner’s age. The MDIB table is a published table of joint life expectancies for 
an owner and a beneficiary who is ten years younger than the owner. It simplifies the 
calculation to only using the owner’s age. No beneficiary information is needed, and no 
recalculation options are available. There is only one exception to this rule – for cases 
involving spousal beneficiaries that are more than ten years younger than the owner. 

Situation 2: Owner dies with nonspousal beneficiary 

When the owner dies with a nonspousal beneficiary, a term certain distribution period is 
established, based on the designated beneficiary's single life expectancy in the year after 
the owner’s death. As with the old term certain method, this life expectancy is simply 
reduced by one for each year after it is calculated. 

Situation 3: Owner dies with no beneficiary 

This is the only situation where the owner’s required beginning date is relevant. If the 
owner dies before the required beginning date, and there is no beneficiary alive as of 
12/31 of the year following the owner's death, the five year rule applies – all the money 
has to be distributed within the next five years. 

If the owner dies after the required beginning date, and there is no beneficiary alive as of 
12/31 of the year following the owner’s death, the distributions are taken out over a term 
based on the owner’s life expectancy in the year of death. Once again, this works the 
same as the old term certain method, with the life expectancy being reduced by one for 
each year that passes after the owner’s death. 

Situation 4: Owner dies with spousal beneficiary 
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When the owner dies with a spousal beneficiary, the spouse gets special treatment. In this 
case, required distributions are generally based on the spouse’s single life expectancy in 
each year after the owner’s death.  

If the owner dies prior to the calendar year in which he would have reached age 70½, the 
spouse does not have to start taking distributions until that year. However, if the owner 
dies before 12/31 of the calendar year in which he would have reached age 70½ and the 
spouse also dies before 12/31 of the calendar year in which the original owner would 
have reached age 70½, then the second-to-die spouse is treated as the new owner with the 
rules of Situation 2 being applied if the second-to-die spouse has a designated beneficiary 
or Situation 3 if there is no designated beneficiary.  

If the spouse dies after the year in which the original owner would have turned 70½, the 
distributions become term certain, with the term set to the spouse’s life expectancy in the 
year of death. Again, this works the same as the old term certain method, with the life 
expectancy being reduced by one for each year that passes after the spouse’s death. 

Situation 5: Owner dies and a spousal rollover 

When the owner dies with a spousal beneficiary, the spouse has the option of doing a 
spousal rollover with the spouse becoming the new owner.  In such a case, the rules of 
Situation 1 apply after the spouse becomes the new owner.   

Situation 6: The Exception to Situation 1 

The exception to situation 1 is when there is a spousal beneficiary who is more than 10 
years younger than the owner. In this case, the life expectancy used while the owner is 
alive is the joint life expectancy of the owner and spouse, recalculated in each year. Once 
the owner dies, the exception no longer applies, and the distribution is handled according 
to the situations described above. 
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1987 Proposed Regulations (Pre-2001 Rules) 

If the plan owner has not named a beneficiary 

If the plan owner has not named a beneficiary, then there are two methods for 
determining the plan owner’s life expectancy each year: Term Certain method or 
Recalculation method. Use the Recalculate Owner’s Life Exp. check box to determine the 
method: 

• Term Certain method—Clear the Recalculate Owner’s Life Exp. check box. The 
program uses Table V to determine the owner’s life expectancy in for the Required 
Beginning Date (first year that distributions are required). Thereafter, the program 
subtracts one from the life expectancy each year. 

• Recalculation method—Click the Recalculate Owner’s Life Exp. check box. The 
program uses Table V to determine the life expectancy each year. 

If the plan owner has named a beneficiary 

Plan owners and beneficiaries have the ability to recalculate their life expectancies 
annually (see Note). If the plan owner has named a beneficiary, then there are actually 
four methods of recalculating life expectancies each year. Use the Recalculate Owner’s 
Life Exp. and the Recalculate Beneficiary’s Life Exp. check boxes to determine the 
method: 

Joint Recalculation method—Click both check boxes. Both life expectancies are 
recalculated. The program uses Table VI to determine the minimum distribution from the 
life expectancies.  

Joint Term Certain method—Clear both check boxes. Neither life expectancy is 
recalculated. Both the owner and the beneficiary use the term certain method. Both life 
expectancies decrease by 1 annually.  

Hybrid method—Only click Recalculate Owner’s Life Exp. The owner's life expectancy 
is recalculated and the beneficiary uses the term certain method. Using the beneficiary's 
deemed age ((determined using single life Table V) and the owner's actual age, the 
program uses joint life Table VI to determine the minimum distribution. Many planners 
recommend this method when the plan owner is older than the beneficiary. 

Hybrid method—Only click Recalculate Beneficiary’s Life Exp. The beneficiary's life 
expectancy is recalculated, and the owner uses the term certain method. Using the 
owner's deemed age (determined using single life Table V) and the beneficiary's actual 
age, the program uses joint life Table VI to determine the minimum distribution. Planners 
recommend this variant when the beneficiary is older than the plan owner. 
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Mortality Table 

When appropriate, the program offers the 90CM Table, the §1.72 (1983 table listed in 
IRS Regulations §1.72-7(c)(1)(iii)), the UP-1984, and the 80CNSMT (1980 table from 
IRS publication 1457).  The example in IRS Notice 89-25, 1989-1 C.B. 662 uses the UP-
1984 Mortality Table. As of May 1, 1999, the IRS released the 90CM mortality table. 
This table replaces the older 80CNSMT. Between May 1, 1999, and June 30, 1999, you 
can use either the 80CNSMT or the 90CM. After June 30, 1999, do not use the 
80CNSMT (REG-103851-99). 

Note 
Brentmark has permission to use the UP-1984 Table Copyright(c) 1976 Conference of Consulting Actuaries, 
All Rights Reserved. 
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License Agreement   

 
This software is protected by both United States copyright law and international treaty provisions.  You 
must treat this software just like a book, except that you may copy it onto a computer to be used and you 
may make archival copies of the software for the sole purpose of backing up our software and protecting 
your investment from loss.  You must also agree not to reverse engineer the software. 
 
By saying “just like a book,” Brentmark means, for example, that this  software may be used by any number 
of people, and may be freely moved from one computer location to another, so long as there is no 
possibility of it being used at one location or on one computer while it is being used at another.  Just as a 
book cannot be read by two different people in two different places at the same time, neither can the 
software be used by two different people in two different places at the same time (unless, of course, 
Brentmark’s copyright is being violated).   
 
Limited Warranty 
Brentmark Software, Inc. warrants the physical diskette(s) and physical documentation enclosed herein to 
be free of defects in materials and workmanship for a period of 60 days from the purchase date.  If 
Brentmark receives notification within the warranty period of defects in materials or workmanship, and 
such notification is determined by Brentmark to be correct, Brentmark will replace the defective diskette(s) 
or documentation.   
 
The entire and exclusive liability and remedy for breach of this Limited Warranty shall be limited to 
replacement of defective diskette(s) or documentation and shall not include or extend to any claim for or 
right to recover any other damages, including but not limited to, loss of profit, data or use of the software, 
or special, incidental or consequential damages or other similar claims, even if Brentmark has been 
specifically advised of the possibility of such damages.  In no event will Brentmark's liability for any 
damages to you or any other person ever exceed the lower of suggested list price or actual price paid for the 
license to use the software, regardless of any form of the claim.   
 
BRENTMARK SOFTWARE, INC. SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Specifically, Brentmark makes 
no representation or warranty that the software is fit for any particular purpose and any implied warranty of 
merchantability is limited to the 60-day duration of the Limited Warranty covering the physical diskette(s) 
and physical documentation only (and not the software) and is otherwise expressly and specifically 
disclaimed.   
 
The limited warranty gives you specific legal rights; you may have others that may vary from state to state.  
Some states do not allow the exclusion of incidental or consequential damages, or the limitation on how 
long an implied warranty lasts, so some of the above may not apply to you.   
 
Governing Law and General Provisions  
The License Statement and Limited Warranty shall be construed, interpreted and governed by the laws of 
the State of Florida and any action hereunder shall be brought only in Florida.  If any provision is found 
void, invalid or unenforceable it will not affect the validity of the balance of this License and Limited 
Warranty which shall remain valid and enforceable according to its terms.  If any remedy hereunder is 
determined to have failed of its essential purpose, all limitations of liability and exclusion of damages set 
forth herein shall remain in full force and effect.  This License and Limited Warranty may only be modified 
in writing signed by you and a specifically authorized representative of Brentmark.  All rights not 
specifically granted in this statement are reserved by Brentmark.  
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